
Un outil pour gérer sa bibliographie
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Découvrir et 
prendre en 

main
le logiciel



Caractéristiques techniques

 Logiciel libre et gratuit : http://www.zotero.org/

 Créé en 2006 et soutenu par George Mason University (USA)

 Multiplateforme : Windows, Linux et Mac 

 Navigateurs : Firefox, Safari, Chrome

 Couplage avec Word, LibreOffice

 Version Internet : outil de partage de références et réseau social 

http://www.zotero.org/


Les différentes versions de Zotero

 Zotero (auparavant appelée Zotero Standalone) : à installer sur son 

poste de travail

 La version plug-in de Firefox (version historique) n’existe plus en 

version 5

 Plateforme Web de partage de références

 Version mobile (Android, iPhone, iPad) : pas de version officielle 

(voir en fin de support)

La version courante est la version 5 (sortie en juillet 2017)
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Installation

 https://www.zotero.org/download/

 Deux actions :

1. Installation de Zotero

2. Installation du plug-in Firefox selon le navigateur utilisé

https://www.zotero.org/download/




Fenêtre principale de Zotero

Les collections
Tableau des références

Détail d’une

référence

Recherche par  

marqueurs

(mots-clés)

PDF attaché à 

la référence



Détail d’une référence

4 onglets :

• Info = auteurs, titre, …

• Notes = notes de lecture

• Marqueurs = Mots-clés

• Connexe = établir un lien 

entre deux notices



Gestion de l’affichage

 Les intitulés de colonnes sont cliquables pour mettre en œuvre un tri 

 Le choix des colonnes affichées peut être modifié



Les icônes dans Zotero

Icône Action Icône Action

Créer une nouvelle collection Attacher un PDF à une référence

Gestion des flux et des groupes Recherche avancée

Saisie d’une nouvelle référence Localiser sur Internet

Création de référence par le DOI, l’ISBN, … Synchroniser

Ajouter une note indépendante Menu Edition Préférences



Personnalisation de Zotero

 Importance des choix de paramétrage (Edition >Préférences) 
pour :

• Le choix du répertoire de stockage des références et des PDFs, utile 
pour les sauvegardes

• La récupération automatique de PDF si l’accès y est possible

• L’installation ou la ré-installation du Add-in Word

• L’indexation des PDFs pour la recherche

• L’installation de nouveaux styles utilisables avec le Add-in Word

• La déclaration d’un résolveur de lien utile avec l’icône « Localiser »

• Etc.



Enregistrer des 
références 

bibliographiques



Différentes possibilités pour alimenter sa 

bibliothèque Zotero

 Import automatique de références 

 Import de fichier  :  Fichier > Importer

 Création de références à partir des fichiers PDFs : glisser-déplacer  

 Saisie manuelle 

 Création à partir d’un identifiant  : DOI, ISBN, PMID

 Flux RSS 

 Récupération des références d’un document word
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Reconnaissance de la(des) référence(s) 

contenue(s) dans la page de résultats

Si une référence est

affichée

Si un lot de références

est affiché

Importance des préférences pour l’import des textes intégraux (voir plus loin)

Manipulation pertinente avec un faible nombre de résultats



Processus de collecte

Import immédiat dans 

Zotero, on pourra 

ensuite renommer les 

fichiers PDFs par clic 

droit + Renommer le 

fichier à partir des 

métadonnées du 

parent



Vérifier les préférences

Récupération automatique des PDFs possible seulement à partir 

des sites des éditeurs et si l’accès est autorisé pour l’Inrae





Import d’un lot important de références 

depuis Wos : création d’un fichier en 

format BibTeX

Les références seront importées dans 

une collection portant le nom du fichier 

importé (savedrecs, …)



Import d’un lot important de références 

depuis PubMed : création d’un fichier en 

format .txt ou .nbib

Les références sont importées dans une collection portant le nom du 

fichier importé (pubmed-result… avec comme extension . txt ou .nbib )

 2 possibilités d’import de références par lot  : Save ou Send to

Dans PubMed :

• Cliquer sur : Send to

• Cliquer sur : Citation Manager

• Cliquer sur : Create File

• Enregistrer le fichier

Dans Zotero :

• Fichier

• Importer le fichier .nbib

Dans PubMed :

• Cliquer Sur Save

• Sélectionner le Format : PubMed

• Cliquer sur : Create File

• Enregistrer le fichier

Dans Zotero :

• Fichier

• Importer le fichier .txt





Création automatique d’une référence à 

partir d’un fichier PDF (1ère méthode)

1.Stocker une copie du fichier (c’est le PDF enregistré sur votre ordinateur)

2. Clic droit > Récupérer les métadonnées du PDF

3. Clic droit > Renommer le fichier à partir des métadonnées du parent



Création automatique d’une référence à 

partir d’un fichier PDF (2ème méthode)

 Glisser-déplacer les PDFs vers la fenêtre centrale à l’aide de 

l’explorateur de fichiers

La référence 

n’est pas créée





Saisie manuelle des références

 Nouveau document : commencer par choisir le type de document 

parmi les 34 proposés

. Saisir toutes les informations

. Pas de champ obligatoire

. Respecter l’ordre des auteurs : 

Nom, Prénom

. Aide à la saisie pour les 

auteurs, le nom du journal





Collecte automatique de notices 

ibliographiques à partir d’un DOI, d’un 

ISBN ou d’un PMID



Outils de correction automatique

 Sur la référence complète avec un clic droit :

• Sur le Titre ou la Publication : pour transformer les majuscules en 

minuscules

• Sur l’auteur : pour inverser le nom avec le prénom
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Alimentation de la bibliothèque par les flux 

RSS (1)

 Fils ou Flux RSS : Really Simple Syndication

 Fichier texte, basé sur le langage XML. Contient la 

description des nouveautés mises en ligne sur un site et le 

lien sur les informations

 Permettent de suivre facilement les nouveaux contenus d’un 

site Web

Pour recevoir automatiquement les nouveautés :

 d’une revue (dernier sommaire, article sous presse)

 d’un organisme (Ministère, ONG, association…)

 d’une archive ouverte (HAL…)
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Alimentation de la bibliothèque par les flux 

RSS (2)

Créer un nouveau flux par son URL 

 Repérez les sites que vous voulez surveiller

 Cliquer sur le logo du fil RSS pour afficher le flux et copiez l’URL
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Alimentation de la bibliothèque par les flux 

RSS (3)

 Déclarer le flux dans Zotero

 Consulter vos flux dans Zotero

Modifier / Se désabonner
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Alimentation de la bibliothèque par les flux 

RSS (4)

Ou récupérer les flux à partir d’un fichier OPML (format XML)

Dans le cas où vous utilisez déjà un agrégateur de flux RSS (Feedreader, netvibes,  …)

vous pourrez exporter l’ensemble de vos abonnements

 Exemple à partir de Feedreader  Exemple à partir de Netvibes : afficher son 

compte puis sauvegarder les données
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Alimentation de la bibliothèque Zotero par 

les flux RSS (5)

 Créer une référence à partir d’un flux 

Cliquer sur le titre d’un flux RSS Sélectionner Ajouter à « Ma bibliothèque »

Possibilité 

d’alimentation

une collection ou un 

groupe partagé

(voir cette partie)
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Repérage des travaux rétractés après 

publication

 Grâce à un partenariat avec Retraction Watch, Zotero signale les 

articles contenant des erreurs (méthode, calcul, analyse…). Ces 

articles sont placés dans la collection « Retracted items ».

 Fonctionnalité limitée aux références contenant un DOI ou un PMID.

 La citation de tels articles dans Word provoque un signalement de 

Zotero. 
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classer 

les références



Organiser les références : les collections

 Créer des collections pour un rangement thématique ou utilitaire

 Pour alimenter une collection : glisser-déplacer une ou plusieurs 

références vers la collection choisie

 Une collection peut être renommée, supprimée, supprimée en même 

temps que les références qu’elle contient (par un clic droit sur le nom 

de la collection)

 Des collections sont créées par Zotero lui-même en cas d’import de 

références depuis WoS ou PubMed, le ménage est à effectuer par 

l’utilisateur

 Une collection peut contenir des sous-collections



Organiser les références : les collections

 Toutes les références sont dans « Ma bibliothèque » 

 Une référence peut être multi-positionnée dans plusieurs collections

Par un simple glisser-déposer

 Pour déplacer une référence (sans la copier) 

Maj + Alt ou Ctrl + Maj 

 Pour localiser une référence dans les collections

CTRL sur une référence. La(es) collection(s) est(sont) alors 

temporairement colorée(s) en jaune.

 Pour supprimer une référence d’une collection

Clic-droit sur la référence 



Organiser les références : les collections

 « Non classés » contient les références qui ne sont classées dans 

aucune collection

 « Mes publications » permet de ranger ses propres publications pour 

les afficher sur son profil sur Zotero.org (voir plus loin le 

fonctionnement)

 Des collections dynamiques mises à jour automatiquement lors des 

nouveaux imports ou saisies dans la base





Recherche rapide

 Recherche simple

• Dans les références

• Dans les fichiers attachés : les PDFs sont indexés

Pour un bon fonctionnement vérifier :

Edition > Préférences > Recherche  

 Recherche par marqueurs (mot-clé) 

Recherche d’un 

marqueur 

Un clic sur un marqueur affiche 

toutes les notices qui le 

possèdent, un 2ème clic ré-affiche

la totalité des références



Recherche avancée / Enregistrer la 

recherche sous forme de collection

 Permet d’interroger sur n’importe quel champs de la bibliothèque Zotero ainsi que  
le contenu des PDFs par le champ « contenu de la pièce jointe »

 Les annotations rajoutées aux PDFs ne sont pas interrogeables (sauf si installation 
du plug-in Zotfile - voir + loin)

 Enregistrer sa recherche : une collection dynamique est alors mise en place. Elle 
sera mise à jour automatiquement lors des prochains imports ou saisies de 
références (mise en place d’une veille sur la bibliothèque Zotero)

 Pour la recherche dans le contenu des PDF, il faut régulièrement reconstruire l’index 
Préférences de Zotero > Recherche

Conditions :

« à toutes les » = ET

« au moins à une » = OU



Créer une Chronologie

 C’est un affichage graphique des références selon leur date de publication, 

afin, par exemple, de voir quelles sont les principales étapes de la littérature 

stockée

 Outils>Créer une Chronologie

 A l’aide de la souris, on peut se déplacer

à l’intérieur des différentes échelles de temps

 Exemple de références sur les logiciels

de gestion bibliographique, y sont surlignés

les documents traitant de Zotero, Mendeley,

EndNote
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Dédoublonner

 Zotero alimente une collection « Doublons » lorsque des références 

possèdent des titres / DOI / ISBN identiques

 Lorsque deux références sont en doublon, il est possible de 

fusionner les 2 références

2ème cas : Il n’y a 

aucune différence 

entre les 2 

références (aucun 

symbole à droite) : 

je fusionne mes 

références

1er cas : Je repère 

des différences 

grâce au symbole 

à droite, je choisis 

l’information et/ou 

la référence que je 

veux garder.

Je fusionne 

ensuite





Marqueurs ou mots-clés
 Thématiques ou utilitaires, ils sont importés automatiquement ou saisis 

manuellement

 Affichage des mots-clés

 Pour attribuer un marqueur à une notice :

• Ajout manuel à une référence : Onglet Marqueurs > Ajouter

• Ajout d’un tag existant à plusieurs références :  

o Sélectionner les références

o glisser-déposer les références vers un des marqueurs de la liste des marqueurs (en bas à 

gauche de l’écran principal)

 Recherche par mots-clés : en cliquant sur 1 ou plusieurs marqueurs (AND)

Mots-clés  saisis manuellement

Mots-clés des auteurs importés



Personnalisation des marqueurs ou mots-clés

 9 possibilités de marqueurs colorés : les références se distinguent alors, 

dans la fenêtre principale, par un carré coloré. Accès à la définition des 

couleurs par un clic droit sur le marqueur

 Pour modifier un marqueur sur un lot de références : clic droit > 

Renommer le marqueur

 Il est possible d’ajouter des émoticônes en appuyant sur touche Windows 

+ ; [sur Mac Cmd + Ctrl + Space]



Notes de lecture

 La note de lecture, saisie par l’onglet Notes devient un élément 

attaché à la référence 

 La saisie est facilitée par des fonctionnalités de traitement de texte

 Plusieurs notes peuvent être attachées à une référence

 Le contenu des notes de lecture est interrogeable





Recherche du texte intégral d’une 

référence (1) : clic droit sur la référence

Recherche et 
affichage de 
l’article sur 

Internet



Recherche du texte intégral d’une 

référence

 Pour bénéficier des accès aux ressources électroniques Inra gérées par 

le résolveur de lien SFX :

 Déclarer le serveur OpenUrl Inra dans les Préférences de Zotero :  

Edition > Préférences > Avancées

https://sfx-33inra.hosted.exlibrisgroup.com/33inra



Moteurs de recherche intégrés – Menu 

localiser

https://sfx-33inra.hosted.exlibrisgroup.com/33inra

Affichage

Accès via les abonnements 

de votre établissement

(à partir de URL)

(emplacement du fichier, explorateur de fichiers)

(configurer OpenURL avec résolveur de liens INRAE)Recherche via 

moteurs de 

recherche

(ajouter le code 

dans fichier 

engines.json)

https://zotero.hypotheses.org/3388




Attacher des fichiers aux références

 Possibilité de lier plusieurs fichiers de type différents à une référence

 Attention : si l’on choisit « Joindre un lien vers le fichier », il n’est pas 

recopié dans l’espace de stockage => possibilités de pertes 

notamment pour la sauvegarde

 L’endroit de stockage de la bibliothèque et des fichiers attachés est 

indiqué par :  

Edition>Préférences>Avancées>Fichiers et dossiers>Afficher le dossier contenant les données 

 Rechercher le pdf automatiquement : Clic droit sur la référence   

(meilleurs résultats si OpenUrl)

Le fichier va être re-

copié dans la 

bibliothèque Zotero





Affichage et annotation des PDFs

Ajouter des commentaires 

ou Surligner

Les notes ou commentaires rajoutés dans les PDFs ne sont pas 
« recherchables » dans Zotero => utiliser l’ajout d’une note à la notice

Une solution : télécharger le plugin “Zotfile”
Voir l’installation à la fin du support



Plugin : Zotfile (1)

Pour extraire des notes prises dans un pdf et en faire 
une note fille

• Ouvrir votre pdf

• Ajouter des notes ou surligner des passages dans 
le texte

• Enregistrer votre nouveau fichier pdf

• Dans Zotero, clic droit sur le fichier pdf

• Sélectionnez Gérer les pièces jointes / Extraire les 
annotations

Une note fille est créée avec :

- la note

- le passage surligné

- les pages 

Niveau
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Plugin : Zotfile (2)

 Pour renommer automatiquement les pdfs à l’import de références 

 Une fois Zotfile installé :

L’emplacement de stockage 

déclaré dans les préférences Zotfile

doit être le même que celui des 

préférences de Zotero

Niveau
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Plugin : Zotfile (3)

 Il est aussi possible d’afficher la table des matières du pdf

Niveau
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Plugin : Zotfile (4)

 Pour récupérer et attacher les pdfs téléchargés dans un répertoire 
choisi :

• Paramétrage du répertoire

• Clic droit sur une référence :  

• Le pdf est renommé selon le patron de renommage paramétré

Niveau
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Utiliser et citer 
les références 

dans un 
document





Notion de style

 Un style est un fichier traduisant les instructions aux auteurs d’un 

journal ou d’un ensemble de journaux sur la mise en forme des 

citations dans le texte et de la bibliographie.

 Un style porte le nom du journal en entier ou en abrégé.

 Utilisé avec un traitement de texte (Word ou LibreOffice), il permettra 

une forme facile du texte. 



Recherche d’un style sur Zotero Style 

Repository

 Les styles doivent être installés sur le poste de travail à partir de
http://www.zotero.org/styles

ou : Edition > Préférences > Citer > Styles > Obtenir d’autres styles

Recherche par 

mot du titre

Classement des 

styles par format ou 

par thème

Affichage du rendu 

du style en passant 

la souris sur son 

nom 

http://www.zotero.org/styles


Installer un nouveau style dans Zotero

Le nouveau style est installé

dans Zotero et prêt à être utilisé

Cliquez sur le 

style choisi



Modifier les styles dans Zotero (1)

Nécessite la connaissance du langage XML et des styles CSL 

A partir de Zotero :

 Trouver un style proche de ce que vous voulez obtenir

 Visualiser le style

 Editer et modifier ce style

 Utilisation de l’éditeur CSL (de Zotero) 
https://www.zotero.org/support/fr/dev/citation_styles/style_editing_step-by-step

 Sauvegarder

 Installer le nouveau style dans Zotero

Possibilité aussi d’utiliser un outil CSL en ligne : Visual Editor

http://editor.citationstyles.org/visualEditor/
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Modifier les styles dans Zotero (2)

 Possibilité de demander la création d’un nouveau style à la 

communauté de développement de Zotero

Il est impératif de suivre les différentes étapes :

https://www.zotero.org/support/fr/requesting_styles

 Autres tutoriels pour la modification des styles :

https://drive.google.com/file/d/1dLtU9KuV1T8Y8ikTGiBtS_4XdwxStT7E/view

http://www.thomaslienhard.fr/TutorielZotero.html

https://libguides.biblio.usherbrooke.ca/zotero/autres_fonctions/modifier_ou_ajouter_style_bibliographique
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Edition d’une liste de références 

indépendante d’un texte

 A partir d’une sélection de références ou d’une collection : clic droit + 

créer une bibliographie 

 Sélectionner un style et choisir un format (RTF, HTML ou presse-

papier)

On peut aussi glisser-déplacer 

les items de la fenêtre principale 

Zotero vers la fenêtre Word  (le 

style est alors déclaré dans 

Préférences > Citer





Barre d’outils Zotero dans Word

Insérer 
ou éditer 
une ou 

plusieurs 
citations

Créer ou éditer la 
bibliographie

Préférences / choix du style
Mettre à jour les citations dans 

le texte à partir des 
modifications effectuées dans 

Zotero

Supprimer les liens entre Zotero 
et le texte pour la soumission



Insérer des citations dans un texte Word

 Positionner le curseur à l’endroit du texte où l’on souhaite insérer 
une(des) citations

 Lors de la première insertion de citation, il faut choisir le style à 
utiliser

 Deux mode d’insertion des citations : (on saisit 1 mot)

• Rapide : 

• Vue classique : (on ouvre la bibliothèque) 

Recherche et construction de la liste des citations à insérer à la position du curseur

Interrogation plus ciblée, tri 

manuel des citations, ajout 

de préfixe ou suppression 

de l’auteur dans la citation, 

si plusieurs citations : 

choisir « sources multiples »



Pour sélectionner par défaut le mode 

d’insertion classique

Possibilité de basculer entre les 2 modes



Générer la bibliographie



Changer de style de journal





Gérer l’ordre des citations multiples

 Avec Vue rapide :

 Avec Vue classique

Avec « Trier les sources automatiquement », les 

références seront triées automatiquement dans 

l’ordre ascendant ou descendant, selon le journal 

choisi. Il est aussi possible de glisser déposer les 

références choisies

Cocher «Trier les 

sources 

automatiquement » ou 

classer à l’aide des 

flèches



Modifier l’aspect de la citation (1)

 Avec la vue classique

Possibilités :

- Rajouter la mention de la 

page concernée

- Rajouter un préfixe ou 

un suffixe à la citation

- Supprimer l’auteur



Modifier l’aspect de la citation (2)

 En vue Classique

Ouverture de la référence 

sélectionnée dans un éditeur : 

elle peut alors être modifiée 

(attention, elle ne pourra plus 

être mise à jour)
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Reporter les mises à jour de la 

bibliothèque dans les citations et les 

bibliographies

 Avec Document Preferences :

Niveau
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Abréviation des noms de revues dans les 

bibliographies

 Les abréviations utilisées sont celles de la base de données 

bibliographiques Pubmed. Dans Word :  

Niveau
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Stockage des fichiers et des références

 L’endroit de stockage de la bibliothèque et des fichiers attachés est 

indiqué par :  

Edition > Préférences > Avancées > Fichiers et dossiers > Afficher le dossier contenant les données

Ce répertoire est à utiliser dans les sauvegardes du poste de travail, il 
peut être modifié en cliquant sur « Personnalisé » (à faire juste après 

l’installation). Deux situations possibles :



Organisation du stockage des fichiers 

dans Zotero

 Pour savoir dans quel endroit se trouve stocké précisément un 

fichier attaché : clic droit > Localiser le fichier :

Storage : contient les fichiers 

attachés (pdf, images…)

un répertoire par notice

Zotero.sqlite : contient les 

références, notes, mots-clés
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Echange par export (bibliothèque ou 

collection ou lot de références)

 Fichier > Exporter la bibliothèque (ou sur un nom de collection, clic 
droit + exporter la collection, ou sur un lot de références 
sélectionnées, clic droit + exporter les documents) :

 Fichier > Importer permet de placer ces références dans une 
bibliothèque Zotero

 Le support Zotero ne conseille pas l’export comme mode de 
sauvegarde.

Cocher si besoin l’export 

des notes et/ou des 

fichiers attachés
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Collaborer par échange de fichiers

 Le format du fichier à créer dépend du logiciel vers lequel les 
données seront importées. Pour importer dans :

• Zotero : format export Zotero RDF

• Reference Manager ou EndNote : format EndNote XML+ transfert des 
PDFs via l’explorateur.
Voir à : http ://ist.blogs.inra.fr/questionreponses/2016/06/20/transfert-de-zotero-a-endnote/
Problèmes éventuels si les noms des fichiers pdf sont trop longs, les informations de 
collection ne sont pas transférées.

• Jabref : format BibTeX

 Pour un transfert vers Mendeley : la bibliothèque Zotero (fichier 
zotero.sqlite) étant placée sur le disque dur, un import automatique 
(« continuous import ») est prévu via la déclaration de la bibliothèque 
Zotero dans Mendeley : Tools > Options > Zotero

• Cet import ne fonctionne pas correctement avec la version 5 de Zotero au 
21/08/2017

• Faire un export de la base Zotero en format Bibtex (Fichier > Exporter) 
puis, dans Mendeley, un import (File > Import)
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http://ist.blogs.inra.fr/questionreponses/2016/06/20/transfert-de-zotero-a-endnote/


Import d’un fichier EndNote dans Zotero

 Dans EndNote, après avoir activé le style Format Refman RIS 

Export (catégorie Export), exporter les références : File > Export :

 Dans Zotero, Fichier > Importer 

 Les références sont placées dans une collection portant le nom 

du fichier importé 

Si la bibliothèque EndNote contient 

des PDFs, créer le fichier d’export 

sous le répertoire .Data de la 

bibliothèque EndNote, voir à :: 
http://ist.blogs.inra.fr/questionreponses/20
15/03/13/transfert-de-references-et-de-pdf-

de-endnote-a-zotero/ à : 
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http://ist.blogs.inra.fr/questionreponses/2015/03/13/transfert-de-references-et-de-pdf-de-endnote-a-zotero/


Import d’une bibliothèque Mendeley dans 

Zotero

 Export BibTeX, liens vers les PDFs conservés, perte des groupes

 Dans Mendeley : File > Export, choisir un format BibTeX

 Dans Zotero :  Fichier   > Importer

 Les références sont placées dans une collection portant le nom du 

fichier importé 

 La répartition en groupes de la bibliothèque Mendeley, certains 

fichiers attachés, des enrichissements dans les Notes (gras) ne sont 

pas conservés.
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Sauvegarde des données dans Zotero / 

Echanges avec Desktop

AgriGénomique – Recherche Doc et Zotero

96

Synchronisation entre Desktop et Web

Références bibliographiques personnellesRéférences partagées
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http://www.zotero.org/


Préparer la synchronisation

 Cette manipulation a pour but de créer une copie de la bibliothèque 
dans zotero.org

 L’espace est gratuit jusqu’à occupation de 300 MB

 Se créer un compte sur Zotero.org :

 Configurer  Zotero pour la synchronisation :

 Si le texte intégral est synchronisé, l’occupation d’espace sur 
Zotero.org augmentera beaucoup plus rapidement

 On pourra, la synchronisation faite, accéder à ses références de 
n’importe quel appareil connecté à Internet

Importance de ces deux choix
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Synchronisation des deux espaces

 Si l’on n’a pas programmé la synchronisation automatique, il faut 

utiliser l’icône :

 Visualisation de l’espace sur Zotero.org :

Niveau
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Pourquoi partager ses références sur 

Internet?

 Pour un travail collaboratif avec des collaborateurs éloignés 

dans le monde entier

 Pour gérer les publications d’un collectif et les afficher sur 

Internet

 Pour afficher son profil personnel : Zotero est aussi un 

réseau social (People)
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Les groupes
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Voir et participer à des groupes publics

 Recherche de groupes : 

 Inscription à des groupes publics 
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Organisation du partage

 3 types de groupes de partage :

• Privé : le groupe est visible des membres seulement

• Public avec adhésion restreinte : une invitation est nécessaire pour rejoindre 
le groupe

• Public avec adhésion ouverte : le groupe est visible de tous et tout un chacun 
peut le suivre

 Trois rôles :
• Administrateur, propriétaire, membre

• Qui peut lire, ajouter ou modifier les références, qui peut ajouter les pièces 
jointes ?

Dans les groupes 

de partage 

publics, on ne 

peut pas stocker 

de fichiers PDFs
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Création d’un groupe de partage sur 

Zotero.org

 Groups > Create a new group

Niveau
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Définition des rôles des membres
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Invitation des membres par mail ou 

acceptation des demandes
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Ajout de références dans un groupe 

partagé

 Consultation, dépôt de références dans les deux sens, création de 

collections… sont faisables depuis Zotero

 Toujours synchroniser pour exporter les modifications de Zotero à 

Zotero.org 

 Et rafraîchir la page Zotero.org pour afficher les modifications 

 Voir aussi les préférences de synchronisation

Cocher « Synchroniser les fichiers joints 

dans les bibliothèques de groupe » peut 

ramener un grand nombre de fichiers 

attachés qui seront stockés sur le disque dur. 

Attention à la capacité de stockage gratuite !
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Echanges dans un groupe partagé

 Des discussions sont possibles entre les membres du groupe 

partagé : autoriser les commentaires dans le profil du groupe 
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Supression d’un groupe

 Les propriétaires de groupe peuvent supprimer le groupe à partir de 

la page « profil de groupe » (sur le site zotero.org )
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2



Niveau

2



Recherche de personnes

Voir son CV, l’inviter sur des 

groupes, visualiser ses groupes 

publics…
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Enregistrer et gérer son compte

 Permet de créer son curriculum vitae (C.V.), d’effectuer des choix 

d’affichage (Privacy), de voir l’espace occupé sur zotero.org 

(Storage)…
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Affichage de la liste des publications

 Les références rangées dans la collection « Mes publications » 

seront affichées automatiquement dans le profil personnel sur 

zotero.org

 Lors de l’alimentation de la collection « Mes publications », 

Zotero propose de faire des choix sur la diffusion des textes 

avec, éventuellement le choix d’une licence Creative Commons :

 L’affichage dans le profil tient compte des types de documents 
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Utilisation de Zotero et de Google Docs 

sans intégration du Zotero Connector (1)

 Le texte est saisi sur GoogleDocs et partagé 

 Les références à citer dans le document Google Docs sont dans un 

groupe partagé

 Dans Zotero, choisir le style à utiliser dans les Préférences : 

Edition  > Préférences >  Exportation 
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Utilisation de Zotero et de Google Docs 

sans intégration du Zotero Connector (2)

 Dans Zotero, pour chaque référence à citer, on utilise : 

• CTRL + Shift + A : pour copier dans le presse-papier la référence telle 

qu’elle doit apparaître dans le texte selon le style choisi 

• CTRL + Shift + C : pour copier dans le presse-papier la référence telle 

qu’elle doit apparaître dans la bibliographie selon le style choisi 

 Dans Google Docs, pour chaque référence à citer, on utilise : CTRL 

+ Shift + V pour :

• Coller la référence dans le texte

• Alimenter la bibliographie

Il ne sera pas 

possible de 

changer le style 

bibliographique 

choisi

Il est aussi possible de 

glisser-déposer les 

références depuis la 

fenêtre Zotero (shift-

glisser-déposer pour la 

forme Citation)
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Utilisation de Zotero et de Google Docs 

avec intégration du Zotero Connector (1)

 Préférences du Connecteur :

 Lors de la première utilisation : 
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Utilisation de Zotero et de Google Docs 

avec intégration du Zotero Connector (2)

 L’onglet Zotero apparaît dans Google Docs :

 Les fonctionnalités sont identiques à celles de l’onglet Zotero de 

Word ou LibreOffice
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Utilisation de Zotero et de Google Docs 

avec intégration du Zotero Connector (3)

 La bibliographie peut-être modifiée par exemple en choisissant un autre 
style (Add/Edit Bibliography)

 Ce processus est lent, notamment si le nombre de citations est élevé

 Il est aussi conseillé de travailler à partir d’un groupe partagé

 Plusieurs contributeurs ne peuvent pas insérer ou éditer les citations en 
même temps

 Pour utiliser le fichier : créer une copie (Fichier>Créer une copie) puis, sur 
ce fichier, utiliser Zotero > Unlink Citations

 Plus de détails à : https://www.zotero.org/support/google_docs
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https://www.zotero.org/support/google_docs
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Zotero et versions mobiles

 Il n’y a pas d’application Zotero officielle pour Android, iPhone et 

iPad

 Plusieurs solutions possibles : https://www.zotero.org/support/mobile

 Barcode Scanner by IOS (Ipad, Iphone) permet d’ajouter des 

ouvrages en scannant leur code-barre

 Scanner for Zotero (Android) permet d’ajouter des documents dans 

sa bibliothèque Zotero en scannant leur code-barres ISBN
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Plugins for Zotero

 Une communauté active d’utilisateurs

 Des plugins pour différents usages : des utilitaires, des 

outils d’intégration (par exemple pour intégrer R/Rstudio

avec Zotero) ou des « rajouts » pour mieux travailler avec 

LaTeX, WordPress, Spip…

 Accès aux plugins : 

https://www.zotero.org/support/plugins 
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Installation du Plugin : Zotfile

Procédure

 Aller sur Zotfile.com

 Clic droit sur le bouton « Download »  puis « Enregistrer la 

cible du lien sous… »

 Télécharger « zotfile.xpi » sur son ordinateur

 Aller dans Zotero : Outils > Extensions 

 Cliquer sur la roue (en haut, à droite), puis  : Install add-on

From File

 Sélectionner le ficher « zotfile.xpi »

 Redémarrer Zotero
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Plug-in Zotero DOI Manager : ajout de DOI 

et nettoyage (doubons) + formes courtes

Peut être appliqué 

sur une sélection 

de références

Pour installer un Plugin pour Zotero
Enregistrer le fichier .xpi (par exemple zotero-shortdoi-1-3-9.xpi)

Dans Zotero : Outils > Extension          Install Add-on From File
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Autres plugins intéressants

Niveau
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Nb de citations dans Google Scholar

Ajout de l’identifiant PubMed



Gestion des plugins installés (Outils > 

Extensions)
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Récupérer des notices à partir de la 

bibliographie d’un article

 Grâce à l’application en ligne Anystyle.io, vous 

pouvez récupérer des notices depuis un format 

« texte » (traitement de texte, html, …)
http://anystyle.io 

Smil V. 2013. Should We Eat Meat? Wiley-
Blackwell, West Sussex, UK. p. 140.
Steinfeld H, Gerber P, Wassenaar T, Castel V, 
Rosales M, de Haan C. 2006.  Livestock’s Long  
Shadow:  Environmental Issues and Options. 
Food and Agricultural Organization of the 
United Nations, Rome.
Tuomisto H L, de Mattos M J T. 2011. 
Environmental impacts of  cultured meat
production.  Environmental Science  &  
Technology, 45, 6117–6123.
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Si erreurs, 

modifier 

« Assign Label »

Puis ouvrir Zotero et 

importer le fichier 

« export.bib »

http://anystyle.io/


Extraire des citations et références d’un 

document Word

 https://rintze.zelle.me/ref-extractor/

Export en format 

BibTeX

(à importer ensuite 

dans Zotero)

Copie les 

références sur 

votre 

bibliothèque en 

ligne
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Conclusion

131Infodoc - Gérer ses références avec Mendeley 
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Gérer les références :

Dé-doublonner

Personnaliser

Classer, marquer et 

rechercher ses références

Alimenter sa 

bibliothèque :

Imports à partir de 

sources externes, 

d’autres logiciels, saisie 

manuelle
Exploiter dans un 

traitement de texte :

Editer des 

références,

Citer et créer une 

bibliographie dans 

un document

Gérer les fichiers PDFs :

Importer des PDFs

Editer et annoter les 

PDFs

Partager ses références :

Dans des groupes publics 

ou privés, exposer ses 

publications



Liens utiles

 Zotero francophone : http://zotero.hypotheses.org/

 Support pour des manipulations avancées (modification de styles, 

sauvegardes, utilisation d’extension) : https://www.sites.univ-

rennes2.fr/urfist/ressources/approfondissement-de-zotero

 Tutoriel pour la modification des styles : 

http://www.thomaslienhard.fr/TutorielZotero.html

 De nombreux outils peuvent être ajoutés à Zotero pour les 

imports/exports, pour une amélioration de l’interface, pour une 

analyse de la bibliothèque, pour l’intégration des données dans un 

site Web (avec WordPress, Drupal ou Spip…) et pour l’intégration 

dans les traitements de texte : 

https://www.zotero.org/support/plugins

http://zotero.hypotheses.org/
https://www.sites.univ-rennes2.fr/urfist/ressources/approfondissement-de-zotero
http://www.thomaslienhard.fr/TutorielZotero.html
https://www.zotero.org/support/plugins


Catalogue des Open Class Service Question / Réponse en IST 

ist.inrae.fr/produits-services/

Vous avez des questions sur le processus 
de publication (soumission, réponse à 

l’appel d’un  éditeur…), sur la recherche 
d’information ou de sa gestion, sur la 

veille pour votre sujet…? 
Q/R en IST vous répond en 3 jours

ist.blogs.inrae.fr/questionreponses

S’informer en Open Science

https://ist.inrae.fr/produits-services/
https://ist.blogs.inrae.fr/questionreponses/toutesqr/
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